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Before You Begin

The Geomet Junior User Guide is for new and experi-
enced inspectors. This manual describes the features of Geomet
Junior in a step-by-step procedure that will enable you to
become proficient in measuring and repeating your inspections
using Geomet.

This manual assumes that you are familiar with inspec-
tion procedures as defined in “ASME Y14.5M, Dimensioning
and Tolerancing”. To begin your journey into the world of
Geomet, we suggest you start with the Geomet Junior introduc-
tion.

This introduction provides the following information:

! A description of the individual chapters in this manual.
! A list of conventions used in this guide.
! Where you can find additional information.



How to Use This Manual
Chapter 1, “Introducing the Geomet System”

This chapter reviews the basic concepts of Geomet Junior.  The standard user inter-
face is described in detail taking you through the menu hierarchy, our exclusive
Keystroke Magic(tm) keyboard layout and the icons.  The different parts of the
screen are described.   The Inspection Header and System Option are described.

Chapter 2, “Probe Qualification”

This chapter describes the importance and procedures provided in Geomet Junior
to ensure your styli are properly qualified.

Chapter 3, Geomet Coordinate Systems”

This chapter describes in detail why a Part Coordinate System (PCS) is required
before you start your inspections.  Techniques in establishing a quality PCS are
demonstrated through examples.

Chapter 4, “Basics in Feature Measurement”

This chapter provides, through examples, the different feature measurement capa-
bilities of Geomet Junior.  Each feature is broken down into it’s reportable compo-
nents; how you can utilize these components in your inspection process is
explained.

Chapter 5, “Actions and Feature Construction”

This chapter describes how you can combine features, or a component of a feature
to create new geometry, fully capable of utilization within the inspection process.
Action features include Text, User Prompts, Recalling features and feature state
changes. 

Chapter 6, “Feature and Form Tolerance”

This chapter explains how to apply tolerance to existing features. Junior offers
GeoTol for form tolerance and for position, bi-lateral and true position (GDT).

Chapter 7, “Geomet Junior Feature Enhancements”

This chapter explains how to expand the capabilities of Geomet.



Conventions
The following conventional terms , text formats, and symbols are used throughout
this Users Guide for Geomet Junior.

Convention Meaning

This is representative of our custom keycap labels that when pressed,
performs the selected operation.

Bold Indicates data you must enter on prompted dialog boxes.

Italic Information Geomet Junior prompts that requires a Keystroke Magic
operation.

<F9> The <> symbols represent a selected keystroke, <F9> indicates that
you should press the F9 Function key.

[File-Open] This represents a menu item to select. [File-Open] requires that you
select the File pull-down menu and the select Open from that menu.

! This symbol represents a topic that requires special notation or addi-
tional information to be supplied.

n auto



Finding More Information

Additional information can be obtained from the ASME
Y14.5M-1994 manual “Dimensioning and Tolerancing” pub-
lished by The American Society of Mechanical Engineers. This
manual can be obtained from your local bookstore under ISBN
#0-7918-2223-0 or by writing:

American Society of Mechanical Engineers
345 East 47th Street
New York, NY 10017
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Introducing the Geomet Junior System
Geomet Junior consists of a variety of components to create a complete inspection
system. The minimum basic system consists of the following:

! Coordinate Measuring Machine

! Manual or Electronic Probe or Sensor

! Computer Interface with CMM

! Intel based Pentium II

! 32 Mb minimum Random Access Memory

! 500 Mb Hard Drive

! Windows™ 95

! Geomet Junior Software

! Reference Sphere for Qualification

You should have a sound understanding of the Windows Operating System before
you start using this software. The manual, by its very nature, can only be a refer-
ence for usage of Geomet Junior. It cannot be an acceptable replacement for an
instructional course on using software that is not directly part of Geomet Junior. If
you are new to the Windows™ environment, please refer to a Microsoft Windows
manual. 
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System Components
Please record all model and serial numbers of your associated equipment. This
information is helpful in maintaining service contracts, warranty claims and main-
tenance.

Component Model Serial Number
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Geomet Junior Basics 

Starting and Quitting Geomet Junior

When your Geomet Junior System is installed, a
shortcut icon is placed on your system Desktop pro-
viding you with a direct access to your Geomet
Junior software. With your mouse, double click on
the Geomet Junior icon, see fig. 1-1, and your system
will launch ready for inspecting.

After completing your inspection operations, if you
wish to quit Geomet Junior, pull down the File menu
and select Exit or simultaneously press < Alt > and
the < F4 > key. If you have not saved your work,
Geomet Junior will ask you whether you want to
save your work.

Access Codes

As with all levels of Geomet, you can expand
your features and enhancements through the
use of the Access Code dialog.

Start the Access Code dialog by simultaneously
pressing < Ctrl > + < Alt > + < u >. The dialog
apprears, as shown to the right, from which
you enter your authorization codes. Once you
have entered your code, press the < Accept >
button to activate the change.
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The Geomet Junior Graphic Interface
The main screen offers you easy access to all the power of Geomet® Junior. This is
provided through the Keystroke Magic keyboard or through menus by using a
mouse. Each area of the screen is designed to give you clear and efficient use of
information. 

" The following pages will define the drop down and sub-menus available in Geomet Junior.

"
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Pull Down Menu Hierarchy

How to use the Graphic Interface

To display a pull down menu you can highlight a menu name by clicking on it once with
the mouse. When you do this a pull down menu will follow.

- Or -

To display the pull down without the use of the mouse, hold down the < Alt > key and
press the letter that is underlined corresponding to the menu name you need.

After the pull down menu is displayed, you can click on the command with the mouse, or
press the letter that is underlined.

Some menu items will be disabled or "grayed out". This is a validation process Geomet
uses to restrict access to features that are not available. Example: if your last feature mea-
sured was a 1D Point, the orient functions will be disabled.
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File Command Structures

File Pull Down Commands

New: Initializes the Geomet Junior system and prepares for a new inspec-
tion.

Open: Prompts you to open an existing inspection file.

Save: After writing or inspecting a part, this command asks you for a new
file name under which to save your results. During an inspection it
allows you to perform an interim save.

Save As: Prompts you for a new name under which to save your results.

Run: Auto-cycles the current part program.

Report Header: Provides access to the Report Header for creating or editing.

Page Setup: Provides controls for page format printing.

Print: Prints out a complete inspection report.

Export⇒ ASCII: Export all data points as Stylus ball centers in ASCII format.

Export⇒ DXF: Export all data points as Stylus ball centers in DXF format.

Exit: Leaves Geomet Junior and returns to the Windows desktop.
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Qualify Command Structures

Qualify Pull Down Commands

Qualify Ball Stylus: This command has two options. In the first option Junior does not
have the Advanced PCS and Stylus option active; this is the default
for Junior. When you click on this, you will be prompted to probe the
reference sphere. 

In the second option, Advanced PCS and Stylus option is active, you
will have access to the complete stylus database manager that allows
you to have unlimited qualified stylus.

Use Taper Probe: Not Available.

Reference Sphere: Provides access to setting the default size of the reference sphere that
you use for qualifications.
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PCS Command Structures

PCS Pull Down Commands

Quick PCS: This command provides you with a basic Part Coordinate Setup uti-
lizing a Plane and 3 Points to Establish all PCS components.

Orient: Establishes the primary datum reference in building your Part
Coordinate System (PCS).

Align: Establishes the secondary datum reference for your Part Coordinate
System.

Origin: Establishes the datum used in building your Part Coordinate System.

ICS->PCS: Allows you to complete a new PCS based on new components created
and those in the existing PCS.

Rotate: Creates a new Part Coordinate System, by rotating your existing Part
Coordinate System by a user defined number of degrees around a
specified axis.

Translate: Creates a new Part Coordinate System, by translating the existing Part
Coordinate System by a user defined distance in the X, Y, and/or Z
directions.

Recall PCS: Switches between your defined PCS and the Machine Coordinate
System (MCS).



Introducing the Geomet System: 1 - 9Helmel Engineering Products, Inc.

Measure Command Structures

Measure Pull Down Commands

Point: Prompts the user to measure a Point feature. Through user definition,
this point is a 1D, 2D or 3D point.

Line: Prompts the user to measure a Line feature.

Circle: Prompts the user to measure a Circle feature.

Plane: Prompts the user to measure a Plane feature.

Sphere: Prompts the user to measure a Sphere feature.

Cylinder: Prompts the user to measure a Cylinder feature.

Cone: Prompts the user to measure a Cone feature.

Text: Text input to place onto your inspection report.

Auto Direction: Toggle Auto Direction on/off.

! Note:  In measuring a 1D Point, a Line, or a Plane, the probing direction is either
+X, -X, +Y, -Y, +Z, or -Z, corresponding to the direction the probe will be travel-
ing in as you make contact with the part.  In measuring a 2D Point, the plane that
you want the point projected to must be specified, either XY, XZ, or YZ.  Also, in
measuring a line, the plane that you want the line projected to must be specified.

Auto Direction will eliminate the need to enter the directions, as Geomet will iden-
tify the direction as well as inside/outside features characteristics.
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Construct Command Structures

Construct Pull Down Commands

Line: Constructs a line through a specified number of previously measured
features immediately preceding, (provided they are compatible).

Circle: Constructs a circle through a specified number of previously mea-
sured features immediately preceding, (provided they are compatible).

Plane: Constructs a plane through a specified number of previously mea-
sured features immediately preceding, (provided they are compatible).

Bisector: Constructs a logical feature symmetrically between the two previous-
ly measured features.  Such as a 2D point between two coplanar cir-
cles, or a choice of  two plane possibilities offered by two measured
intersecting planes.

Distance: Provides the distance between the two previously measured features,
(provided they are compatible).

Intersect: Constructs a logical feature at the intersection of the two previously
measured features, (provided they are compatible).  Such as a 2D
point where two coplanar lines intersect, or a 3D line where two
planes intersect

Angle: Returns the angle between the two previously measured features,
(provided they are compatible).

Recall Feat: Brings any previously measured feature, specified by its feature num-
ber, to the end of the feature list for use in a new construction or eval-
uation.
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Tolerance Command Structures

Tolerance Pull Down Commands

GeoTol: This option is available only after feature is  measured or constructed,
GeoTol allows you to choose from the sub-menu only those character-
istics available for the selected feature.

Example: from a Circle, you can derive Circularity and Concentricity.

Geomet Junior supports the following:

! Straightness

! Flatness

! Circularity

! Cylindricity

! Angularity

! Perpendicularity

! Parallelism

! Concentricity

Tolerance: This command prompts you to add tolerance to a feature. This toler-
ance can be Bi-Lateral or GDT.
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Modify Command Structures

Modify Pull Down Commands

(Un)Delete #: Deletes the last measured feature from the feature list, or returns a
feature to the list if it was previously deleted.

Insert: Allows the insertion of a feature after a specific feature.

Move #: Allows the relocation of a feature after another feature, specified by
their respective feature numbers.

Feature Edit #:  Allows changing parameters of an existing feature, such as inch to
millimeters, or cartesian to polar coordinates.

Undo: Provides a one feature undo operation.  It will undo the last feature in
the results area.  If you wanted to undo the last five features, then use
the undo operation five times in a row.
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System Command Structures

System Pull Down Commands

System Options: Provides a dialog for setting the following controls:

• Tolerance default settings

• Decimal place precision

• Unit of Measurement

• Multi-Point form error

• Auto-direction

• Other general system default values

Interface Config: Provides configuration of the interface driver connected between the
computer and the CMM.  This is normally set at installation.
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KeyStroke Magic™

Keystroke Magic™ Overview

Keystroke Magic™ is your access to making your CMM realize its full potential for
fast, accurate quality assurance.

Each function is designed for ease of use. The Part Coordinate System keys are
grouped together in a simple left to right sequence. 1!!2!!3 your inspection is now
beginning.

The custom keycaps are color coded by function to allow a quick visualization of
your keyboard. Throughout this guide we will describe each function and if applic-
able it’s corresponding screen Icon.

Note: The Keystroke Magic™ key labels are optional with Geomet Junior. The labels shown
also cover the enhanced functions of Geomet 101 / 301.

Basic Characteristics of Keystroke Magic™

Many of the keys used in Keystroke Magic™ perform more than one operation. In
Geomet the keyboard is by default in the caps-off and num-lock-on state. If for any
reason the keyboard has been toggled to the caps-on or num lock-off state you
should change them back.

The key shown here is the circle feature command. When you press the circle
key Geomet Junior takes you to the feature measurement operations and
prompts you to gather four data points (or as many points as you specify in the

Minimum Hits part of the System Options window).

However there are times you may want to gather more than four points. The small
“n” in the upper left part of the key cap indicates this feature has a multi-point
option. To enter the number of data points required hold the < ⇑ > shift key down
and press the circle key. You will be prompted to enter the number of data points
you would like to gather. Up to a point the quality of your measurements will
improve by increasing the number of points used in a measurement . For most
measuring tasks, 6 to 12 hits does an adequate job. Once you have taken 20 or 30
hits, the next hit is unlikely to add significant, new information in the calculation of
the size and location of that feature. Ultimately you must decide what is best for
your application.

Jump n auto
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Vector +X +ZOR +Yn auto auto
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Geomet Junior Screen Layout

Geomet Junior Screen

" Tool Bar: All major functions are depicted here for point and click access. When a
feature is not available it will “grey out” until conditions are set to activate it.

# Digital Read Out: Represents the current location in the MCS or the current PCS.
Includes a local Zero option to obtain relative positioning data. Tip! Point at the
DRO and click your right mouse button, you can change size and precision.

$ Status Banner: This is your main prompt area.  From here you will receive current
status which indicates whether the system is currently in a PCS or MCS, inch or
millimeter, and cartesian or polar coordinates.  On the right you have a count down
area when gathering data points.  The PCS setup guide is displayed to prompt you
through the elements needed for completing a PCS.

% Results Area: This area provides you with a scrolling report of your part inspection.
Results include a sequential feature number, a description of the feature by type,
the number of hits used in the measurement (in parentheses) or a recall indication
(RCL), as well as the feature size, location and attitude (when appropriate).  When
you want to print the results, they will appear exactly as they are on the screen.

"

#

$

%
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On-Screen Digital Readout
Geomet Junior provides real-time On-Screen Digital Readout providing you with
the current location of the Probe.

DRO Basics

When Junior is first started, the DRO
reports the position in the Machine
Coordinate System (MCS). On most manu-
al CMM’s, this is referenced to the position
the system was at when powered-up. Once
a Part Coordinate System (PCS) has been
established, the DRO will report the cur-
rent position in the PCS.

DRO Precision

To change the precision depth or number
height, place your mouse over the DRO
and right-click. A menu will pop-up as
shown in the examples right. Choose the
desired change and the DRO will update
and retain these values until changed again.

DRO Zero

The Junior DRO has the ability to apply a
temporary zero along any axis. This is
accomplished by left-clicking on the but-
tons labels < Zero X >, < Zero Y > and/or
< Zero Z >. When activate the zero option, that axis will change to 0.000 and all
movements will reflect that new position. By clicking the button again, you remove
the zero position and the DRO will return to the original home within the PCS. 
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Inspection Header

Entering your Inspection Header

Geomet Junior provides you with a report
header that prompts you for information
that becomes part of your inspection, see
figure at right. This information can be
updated by pulling down the File menu
and selecting [File->Report Header].

< Accept > Accepts the data in the
Header Dialog and
proceeds to the inspec-
tion.

< Recover File > Recovers the last inspection in the event of power outage or
other fatal system software crashes.

< Load Last > Loads the last saved file for review or continuation.

Drawing #: A drawing or part number used to identify your inspected
part.

Part Name: The part name of the inspected piece; you can enter up to 65
characters.

Serial #: You can assign a special number unique to the part that is
being inspected.

Operator: Place your name in this field.

Date: The date is automatically entered. If you wish to override, just
tab to this field and enter your own date.  The date field
accepts any format you wish to use.

Notes: This field allows you to enter up to 256 characters to attach a
note to the inspection report.
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System Options

Establishing System Defaults

System Options are available to customize
the start-up characteristics of your system.
To access this function, press the < F9 >
function key or from the menu, choose
[System->System Options].

Minimum Hits: Specifies the default
number of probed
points for each type of
feature.

Multi-Pt: Sets limit for warning
when poor feature
form is detected.

Default State Toggle: Allows settings for
inch/mm,
Cartesian/polar, etc.

Enable Auto Sensing: Activates or De-Activates system wide the Auto Direction
Feature. Note: you must have Auto Direction enabled in order to use
GeoMagic.

Enable GeoMagic: This Activates or De-Activates the GeoMagic capability inside
Geomet.

GeoMagic Fit: This setting controls the form fit evaluation zone that
GeoMagic uses in determining the feature characteristics. The
smaller the zone, the more accurate form your features must
have before they are identified by GeoMagic.

< Update > Normally changes to the System Options are defaults that are
set during a restart or when creating a new file. If you want
these changes to take effect immediately, press the <Update>
button.
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Probe Qualification

Why Calibrate the Stylus?

Imagine you are using a probe with a stylus tip (the
ruby ball) that has a diameter of .25”, then you measure
an inside diameter that is 1”.  It is easy to understand
that the computer calculates the diameter as .75”,
because it does not know the size of the stylus.  If we
can calibrate the stylus, then the system is smart enough
to add the tip size, .25”, to the calculated diameter, .75”,
and report a probe compensated measured value of
1.000”.

How do you Calibrate the Probe?

There are three ways to initiate the probe calibration process: (1) from the main
menu select [Qualify->Qualify Ball Stylus], (2) click on the Probe Calibration
icon, or (3) pressing the < w > on the keyboard.  Each will display in the status

banner to “Qualify Stylus (Ball)” with five points remaining to be taken in the
count down box.  Capture four points along the equator of the reference sphere,
and one point on the top, see figure at above-right.

After you have qualified the stylus, it is not necessary to re-qualify it unless you
make a change to the probe configuration, (like changing to a larger or smaller sty-
lus), or if you reposition the reference sphere. The qualification will be fine for the
next job or even throughout the day.  It is a good idea to qualify at least once each
day even if you are not changing the probe setup.

Basic Stylus Option

Geomet Junior offers the use of one Stylus in your part inspection. A basic part
inspection consists of one probe, which is qualified at the beginning of the inspec-
tion and limits the use of configurations such as clusters. If you require additional
stylus configurations you should acquire the Advanced PCS and Stylus option
available to Junior, or acquire a higher level of Geomet such as 101 or 301.

ReQual
Stylus

Manager
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Advanced Stylus Option
If you have acquired the Geomet Junior option: Advanced PCS and Stylus, you
have access to qualifying and using several probes simultaneously. This allows cap-
turing data points on different sides of a part such as a through bore. This option
also supports Manual Indexing Probe Heads allowing repeatable positioning of a
single stylus for access from any direction in your part inspections.

Stylus Manager

The Stylus Manager is activated when you
select the keystroke <w>, choose the
Qualify Icon or from the menu [Qualify-
>Qualify Ball Stylus]. The example at the
right shows the Stylus Manager from
which you can select and qualify all your
probes.

Qualifying from the Stylus Manager

The Stylus Manager allows you to Qualify and Re-Qualify existing probes. To qual-
ify a new probe you must ensure that existing probes are not highlighted in the
Stylus Manager (if a probe is highlighted it becomes a re-qualify as described later
in this section). To start qualifying, press the < Next > button which will guide you
through the process.

The next step is to identify the type of probe you will be qualifying. Geomet sup-
ports probes such as electronic touch styli or hard probes including ball, cylinder,
taper, edge finder and video crosshair. From the drop-down select the type of styli
you have. In this example we are using “ball”. Press the < Next > button and you
will be instructed to capture data points.

Above
are the
basic
steps
used
in the
quali-

fication process.

! you can go from the select screen to the capture data point screen by pressing the <Enter>
key twice. It is not required that you use the mouse to select “ball” on screen two or to press
the < Next > button.
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Qualifying Hard Probes

Hard Probe Basics

Geomet allows the use of hard probes in your part inspections. Hard probes are
quite often the probe of choice in the inspection of sheet metal stamping, basic
machined parts, PC boards and other related production. Geomet maintains the
relationships when switching probes on the CMM. However there are certain
restrictions when using hard probes as described here. (See the “Probe to Feature
Application Chart” found at the end of this section).

Ball Hard Probes

Ball styli are completely universal. They may be used in all attitudes on all
machined surfaces with any measured feature. This probe is similar to the electron-
ic touch probe in its applications. Qualifying of this probe is similar as described
earlier under “Qualifying from the Stylus Manager”.

Taper Hard Probes

Taper probes are designed to be mounted to the CMM in the -Z attitude and their
use is limited to the MCS XY base plane. The Taper probe is designed for use in
centering on bores and slots returning a 2D XY reported feature. It is ideally suited
to the inspection of PC boards where you are required to report the location of all
through holes. Taper probes should only be used with the 2D Point feature found
in Geomet.

To qualify the Taper probe, lock the Z-axis and probe the reference sphere around
the equator. This will ensure the XY components are qualified when switching
between probes.

Cylinder Hard Probes

Cylinder probes are designed to be mounted to the CMM in the -Z attitude and
their use is limited to the MCS XY base plane. Cylinder probes provide edge and
bore locations with proper compensation for the probe size. Cylinder probes are
ideally suited to measure features such as thin walled bores, as which can be found
in sheet metal applications. Cylinder probes use the 1D Point, Line and Circle fea-
tures found in Geomet.

To qualify the Cylinder probe, lock the Z-axis and probe the reference sphere
around the equator. This will ensure the XY components are qualified when switch-
ing between probes.
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Edge Finder Probes

Edge Finder probes are designed to be mounted to the CMM in the -Z attitude and
their use is limited to the MCS XY base plane. Edge Finder probes rotate in a ball
cage mounted to your CMM and can rotate about the Z-axis with an effective probe
compensation of 0.000. This style of probe works with Lines and 2D Points where
the 2D Point is on the surface.

Qualifying requires only the selection of the Edge Finder in the “choose type” drop-
down in step two. Geomet enters a 0.000 as probe size and correlates the XY with
the known center location of the reference sphere.

Video Crosshair

The use of a manual triggering Video Crosshair is available in Geomet. Video
Crosshair probes are designed to be mounted to the CMM in the -Z attitude and
their use is limited to the MCS XY base plane. Video Crosshair works with the 2D
Point, Line and Circle features within Geomet.

To qualify the Video Crosshair, lock the Z-axis and probe the reference sphere
around the equator. Although this can not be used interchangeably with other
probes it can set the diameter of the probe to offset the visual effect of the crosshair
thickness. Often you will have a resulting qualification less the 0.000.

Entered Diameters

Geomet allows you to enter a known diameter of a stylus. This method is not capa-
ble of allowing switching between probes on the same part inspection. You can
enter a negative number for use with probes such as Video Crosshairs.

Probe to Feature Application Chart

Points
1D 2D 3D Line Circle Plane Sphere Cone Cylinder Digitize

Ball X X X X X X X X X X

Taper X

Cylinder X X X X

Edge Finder X X X X

Video Crosshair X X X X

Entered X X X X X X X X X X
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Choosing Styli from the Stylus Manager

To set activate a previously qualified stylus
for use in your part inspection, start the
Stylus Manager < w > and highlight the
desired stylus. You can highlight using
either the mouse and left-click directly on
the stylus LABEL or by pressing the < ⇓ >
down arrow key until the highlight reaches
the desired stylus. Press < Set Active > or
the < + > keystroke.

Once this has been done you will be
returned to your part inspection.

Labeling your Styli

To assist in clarifying different probe configu-
rations, you can attach a label to help identify
each stylus. To do this, highlight the desired
stylus and press < l >    ( for label ) on the key-
board. The current label can now be edited
directly on the select stylus screen as shown
for number 4 in the example at the right.

This method of labeling can be used to identi-
fy the a/b angles used with manual indexing
probes or the position in a cluster configuration.

Setting the Reference Sphere

It is important that you establish the exact size
of your reference sphere. In Geomet Junior
you access this by selecting from the menu
[Qualify->Reference Sphere]. Enter the diame-
ter value in the box as shown in the example.



Reference Sphere

Geomet uses the reference sphere as the basis for multiple stylus support. It is
important to understand how the relationship between the reference sphere and the
qualified stylus work together.

For example, we refer to the first qualified stylus in your system as the Primary Tip.
This tip retains the MCS location of the reference sphere which is then used to qual-
ify the remaining styli. Stylus number 2 will retain a XYZ offset back to tip number
one as well as all remaining tips. This allows us to provide features such as measur-
ing a single feature with any number of tips. This is most useful with manual or
motorized indexing probes and clusters or any combination thereof.

Re-Qualify Existing Styli

To Re-Qualify an existing probe, first high-
light the stylus in the Stylus Manager the
press the < Next > button. Geomet will see
that you have a selected stylus and will
then direct you to re-qualify. You can iden-
tify the Re-Qualify process by noting the
red check as illustrated in the example at
the right.

When you select < Next > from step two,
you will be prompted to probe the refer-
ence sphere or enter the diameter as originally done when creating this stylus.

Special care should be taken when re-qualifying existing styli. You can re-qualify
any existing tip, but not the primary tip. If you are required to re-qualify the prima-
ry tip, you should then re-qualify all remaining tips

Probe Qualification: 2 - 6Helmel Engineering Products, Inc.



Geomet Coordinate Systems

Machine Coordinate System, MCS

The Machine Coordinate System, commonly referred to as the MCS is the XYZ
position of the CMM with respect to the Home Position. The MCS axes are mutual-
ly parallel with the movement of the CMM.

Most manual CMM’s do not have a home position, therefore the home position is
the location of the CMM at the point of starting the system. Some manual systems
do offer a home position that requires the operator to manually move the CMM,
over the reference mark one axis at a time.

In a DCC system, start-up procedure requires that you “Home” the system which
drives to Home and establishes a repeatable XYZ zero point.

A Machine Coordinate System is therefore not a valid coordinate system to obtain
reliable measured values for your part inspection.

Incomplete Coordinate System, ICS

The ICS is an incomplete PCS, namely one which is under construction. The ICS
becomes a PCS once construction is complete or as soon as the < ICS⇒ PCS > key is
pressed.

Advanced PCS and Stylus Option

In the basic Junior program you have access to one PCS. This one PCS can be rede-
fined within your part program. If you have acquired the Geomet Junior option:
Advanced PCS and Stylus, you have access to unlimited PCS and FCS support.
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Part Coordinate System, PCS

The Part Coordinate System or PCS is the foundation that establishes the
Orientation, Alignment and Origin of your part inspection. PCS’s are simply the
frames of reference in which part feature locations are defined. All machines part
drawings are based on PCS’s established by datum features. These drawings are
nearly always 2 dimensional, but machined parts are really 3 dimensional. The 3
dimensional characteristics of machined parts are generally drawn in a series of 2
dimensional projections for the sake of convenience, but in fact a 3 dimensional
PCS is implied. To better understand this let us consider the multi-projection part
referred below:

In order to measure this part on a coordinate measuring machine we shall need to
contact it with probes on all sides. In planning to do this it is helpful to visualize
the 3D coordinate system of the part. Let us do this by making a perspective draw-
ing of the part from one possible direction and then overlaying a 3D PCS. The fig-
ure at the right is one possible view of the 3D dimensional PCS.

The way in which the PCS is overlayed on the
part is determined by the datums defined in the
drawing. Notice that each datum actually repre-
sents a plane: Datum -A- is the ZX plane in
which the plane contains the Z and X axes on the
PCS. Datum -B- is the YZ plane and Datum -C- is
the XY plane. Each of the PCS axes is orthogonal
to the other two and all PCS planes, the XY, YZ
and ZX planes, are orthogonal to one another.
Notice also that the part lies entirely in the posi-
tive octant of the PCS, i.e. all features have posi-
tive X, Y and Z values.

The important thing to remember is that the two
dimensional drawings we deal with are derived
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from three dimensional concepts, and in order to effectively measure a 3D part with
a coordinate measuring machine we must “see” the 3D PCS with the part. This is
made easier by looking at the actual part and at the same time as we study the
drawing and making a habit of constructing imaginary planes in the part represent-
ing the datums defined in the drawing.

PCS versus MCS

Since features of machine parts are defined in terms of their datum references, we
must create Part Coordinate Systems reflecting those datums before the features
can be measured. Since coordinate measuring machines have their own coordinate
system, namely a system of mutually orthogonal axes of motion referred to as the
Machine Coordinate System (MCS), the first problem we face is to create the PCS
within the MCS. This is not trivial.

One way to create a PCS within a coordinate measuring machine is to make the
PCS coincide with the MCS. The procedure consists of physically aligning the
datum surfaces of the part parallel to the axes of motion of the machine and setting
the X, Y and Z displays to zero with an edge finder probe in contact with datum
surfaces or with a taper probe seated in a  datum bore. Once the MCS and the PCS
have been made to coincide, all dimensions found on the display of the coordinate
measuring machine are also feature locations on the part.

Making the PCS and MCS
coincide physically can be
extremely time consuming,
and sometimes impossible.
We can eliminate the problem
by using Geomet to create and
store a skewed PCS. Once a
PCS has been established, the
computer converts raw data
collected in the machine coor-
dinates into measurement
results in part coordinates. In
the figure at the right you will
see a part coordinate system
with X, Y and Z axes nested
inside a machine coordinate
system with its own X, Y and
Z axes.

The MCS and the PCS are totally skewed relative to each other. With the help of
Geomet any point in the MCS can be expressed in the PCS.

As Geomet can manage the link between an MCS and a totally skewed PCS we no
longer need to physically align the parts to the machine. BUT..we need to create the
skewed PCS in Geomet before it can manage the link. The job of creating the PCS
will be simple once we understand a few fundamental principles.
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Part Coordinate System Creation

All Cartesian PCS’s consist of three orthogonal planes whose paired intersections
represent the axes and whose mutual intersection represents the origin of the PCS.
When using a coordinate measuring machine, PCS’s are created by measuring ref-
erence or datum features of the part and then designating them as functional ele-
ments of the PCS using the three Geomet PCS formation commands “Orient”,
“Align” and “Origin”. These three commands are directly mapped to the ANSI 14.5
datum frame components, “Primary”, “Secondary” and “Tertiary” datums.

The first step in forming a PCS is to establish the direction of the PCS axis based on
the primary datum reference on the part. This could be the X, Y or Z axis. Once
determined, this axis and the plane normal to it becomes the primary axis and pri-
mary plane of the PCS. With the primary axis and primary plane established, the
directions of the two remaining PCS axes must be determined. These lie in the pri-
mary plane and make right angles with each other and with the base axis.
Determining their direction is achieved by ALIGNing the interim X and Y in the
primary plane (assuming the primary plane has a Z normal) such that one axis
becomes parallel to the secondary datum feature of the part. The direction of the
third PCS axis is automatically locked in at the same time since it is perpendicular
to the first two by definition. After establishing the directions of all three PCS axes
we need only set a starting or zero point from which to measure distances along
them. This is done by setting ORIGINs on the datum features we measure. The
process of PCS establishment is described in the following examples.

PCS Setup Guide

In order to ensure that a complete PCS has
been established, Geomet provides a visual
PCS Setup Guide to remind you of the miss-
ing components of the current PCS under
construction. The figure at the right shows
the setup guide with all axis and origins still
requiring definition.

When you establish one of the PCS compo-
nents, such as the Z primary axis, the setup
guide will reflect the completion by “sign-
ing-off” that component with a series of
“*******” as shown here.

It should be noted that as long as a PCS is
under construction, no results are displayed
with each measured feature. When the PCS
is completed, the PCS Guide Box will disap-
pear from view.
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PCS Commands in Geomet

Geomet provides several functions to create, recall and transform part coordinate
systems. The following icons are the keycap labels on the Keystroke Magic key-
board layout.

Orient

Orient acts on the last measured or recalled 3D directed feature or pair of non-
directional features which could serve to create a 3D directed feature. Orient sees
through transparent operations such as other PCS formation commands, distance
and angles, etc. Orient establishes the direction of the primary PCS axis, with the
selection of X, Y or Z determined by the MCS X, Y or Z axis to which the directed
feature axis most parallel. Orient will be disabled of feature(s) that are not validated
as having the required components to establish a primary datum.

The Orient command destroys the axis and origin ref-
erences of the previous PCS and, if not already visible,
invokes the PCS Setup Guide. For proper function, the
Orient must be followed by the Align command with
one exception, after performing the orient command,
you can establish the origin on the characteristics of
the feature. An example might be the measuring of a
XY plane, which is used to establish the primary
datum through the orient command along the Z axis,
as shown in the figure at the right. Once the orient has
been completed, you can establish the Z origin on that
plane. 

Another example might be establishing the primary
axis through two spheres, as shown in the example at
the right. Geomet will validate the orient command by
looking back in the inspection. If it finds a 3D feature
that is reported either as a point or sphere, it will con-
tinue to look back until a corresponding 3D feature is
found. The orient function will create the primary
through the 3D point of the two corresponding fea-
tures.

If you elect to apply the origin immediately following
the orient, Geomet will prompt you whether to estab-
lish the origin on the X, Y and/or Z.
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Align

Align acts on the last measured or recalled 3D or 2D directed feature or pair of non-
directed features which could serve to create a 2D or a 3D directed feature. For
example, a pair of 1D co-directional points, pairs of coplanar 2D points, or pairs of
3D points. Align see through transparent operations such as other PCS formation
commands, distance and angle commands, etc. Align establishes the directions of
the secondary and tertiary PCS axes, with the selection of X, Y and Z determined by
the MCS X, Y or Z axis to which the directed feature axis is most parallel. Geomet
will validate the last feature(s) to determine whether they are capable of providing
a secondary datum.

Align, when executed in an ICS directly after orient, makes
an automatic choice of the alignment axis. Align, when exe-
cuted in a PCS results in a re-alignment, whereby the align-
ment axis is determined automatically in the case of a pair
of co-directional 1D points or coplanar 2D features, but
must be specified in the case of a pair of 3D directed fea-
tures by responding to the operator input from the select
base plane dialog as shown to the right.

Offset Align

Offset align acts exclusively on the last measured
or recalled pair of coplanar 2D features. Offset
align requires that you are not in an ICS and
through Geomet validation procedures, this com-
mand will be disabled. The offset align command
will perform a re-alignment of the current PCS.

The first step in establishing the offset align is to
measure or recall two co-planar 2D features. In
the example to the right we will use two XY cir-
cles identified as F1 and F2. The order in which
they are reported in the part program will deter-
mine the re-alignment axis. In this example F2
was measured or recalled after F1. To perform the
re-alignment, press the offset align key < ⇑ > + <
K > and a request will appear for a value to offset
from F2, see figure at right.

The value you enter is the magnitude of the nom-
inal offset and with it’s sign, will control the
direction of the re-alignment. In the example of
offset align figure, the value entered was -0.75 forc-
ing the PCS X axis below F2.
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Pivot Align

Pivot Align acts exclusively on the last 2D or 3D
measured or recalled feature. Pivot align requires
that you are not in an ICS and through Geomet
validation procedures, this command will be dis-
abled. The pivot align command will perform a
re-alignment of the current PCS.

Pivot Align with 2D Features

To perform a pivot align using a 2D feature, press
the pivot align key < Ctrl > + < k >, Geomet will
automatically re-align the current PCS through
the existing origin and the last 2D feature in your
report database. In the example at the right, the
last feature is a XY circle identified as F1. The re-
alignment takes place through the current PCS
origin and the center of the circle, F1.

Pivot Align with 3D Features

To perform a pivot align using a 3D feature such
as a 3D point or sphere, press the pivot align key
< Ctrl > + < k >. Geomet validates the last feature
and after identifying it as a 3D feature, prompts
you to select a PCS base axis which to rotate
about.

For example, if you are to perform a pivot align
using a sphere, you will be prompted to select a
PCS base axis. The base axis represents the nor-
mal axis to the base plane the re-alignment will
take place in. If you selected the Z, The pivot align will take place in the XY base
plane and the projected XY components of the sphere will act as the 2D point which
the re-alignment will take place through.

Origin

Origin acts on the location of the last measured or recalled feature. In the case of
features with 1D locations such as 1D points the origin is established for the direc-
tion of the feature, example a X point establishes the X origin. In the case of features
with 2D or 3D locations, Geomet permits selective setting of an origin in X, Y
and/or Z measured directions. Thus a 2D feature, such as a XY circle, can serve to
set a PCS origin in X, Y or X and Y directions if desired.
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PCS Translate

Translate permits an existing PCS origin to be shifted ny nominal amounts in all
three directions. Translation creates a new complete PCS whose axes are parallel to
those of the preceding PCS but shifted by the input values.

In the example below, PCS 1 is shifted in two directions, XY by the nominal values
of 1.375 for X and 0.75 for Y that has been entered into the Translate Input Dialog.
Upon completion, a new PCS 2 is established. 
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PCS Rotate

Rotate permits an existing PCS to be rotated in
space about one of its own axes. A PCS can only
be rotated about one axis at a time. Compound
rotations must be done in two or more successive
steps. It is important to note the following rota-
tion conventions:

about X: a positive angle produces a counter-
clockwise rotation when looking in
the -X direction.

about Y: a positive angle produces a counter-
clockwise rotation when looking in
the +Y direction.

about Z: a positive angle produces a counter-
clockwise rotation when looking in the -Z direction.

! Note that the sense of directional measurements made with +X, -Y, etc. direction keys
rotates with a PCS rotation. After rotating a PCS whose axes are essentially aligned
with the MCS axes by 90º about the PCS Y axis, a +X measurement is understood
to be directed upward instead of to the right, since that is now the direction of the
+X axis.

ICS ⇒⇒ PCS

The ICS to PCS command converts the status of an incomplete coordinate system to
complete. The effect of this routine is to permit print-out of results if what is nor-
mally considered a complete PCS in the Geomet sense is not required.
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Coordinate System Manager
! The Coordinate System Manager is available only with the Advanced PCS and

Stylus option. 

The CS Manager provides access to recall established part coordinate systems, acti-
vate the machine coordinate system, and if available establish a vector drive coordi-
nate system for manual joystick controls on CMMs with DCC controls.

Recall PCS

Each time a completed PCS is estab-
lished, it is given a ascending num-
ber starting with 1. If you are
requesting a PCS recall, activate the
Coordinate System Manager by
pressing the key < ‘ > and ensure
that the PCS button is pressed in the
Select Type group. Any existing PCS
can then be made the current PCS
by and entering the desired PCS
number. If you were to enter a 0 for
the desired PCS, you are in effect
recalling the machine coordinate
system.

! If you do not have the Advanced PCS
and Stylus support option in your version of Geomet Junior, the CS Manager does
not appear and the command functions as a switch between the Machine coordinate
system and your established part coordinate system.

Recall MCS

In the CS Manager, choose from the Select Type group the MCS button. In effect,
this disables the control where you normally enter a PCS number and upon press-
ing the < Accept > button, recalls PCS 0 which is designated the machine coordi-
nate system by default.
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Recall Vector Drive System

If you have the Direct Computer Control option this command is available. Choose
from the Select Type group in the CS Manager the Vector button. This provides
access to download a chosen established PCS to the motion controller so that your
Joysticks, or Geomet Pendant, will drive the CMM parallel to the PCS axis.

Normally default operating condition requires your joysticks to work parallel to the
machine coordinate system. Once you have established a part coordinate system
that is skewed in all axes to the machine coordinate system it can be difficult to
drive the CMM into slots, small diameters and other detailed features when your
joysticks are mapped to the MCS. Through the CS Manager, choose to vector your
joysticks in any established PCS that conforms to the detailed features. Now when
you deflect the joysticks in the +X, your CMM will move true to the PCS’s +X direc-
tion.

! Caution should be taken as this command is independent of the current PCS and
does not update when you recall another PCS.
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Part Coordinate System Examples
On the following pages we demonstrate several methods of establishing part coor-
dinate systems. Use these exercises as a training tool by following along and exe-
cuting the step-by-step commands.

In all examples we use datum targets to define where you should capture data
points with your probe. By following the examples and executing the required
steps, you will begin the process of understanding the intricacies of using a CMM
correctly, or incorrectly as some examples are designed to demonstrate.

All examples assume you have a qualified probe orientated in the -Z direction
unless otherwise noted.

Table of Exercises:

3.0 Basic Alignment with no Orient

3.1 Basic PCS, Plane-Line-Point

3.2 Quick PCS

3.3 PCS, Plane-Circle-Circle

3.4 PCS, Plane-Cylinder-Circle

3.5 PCS, Plane-Point-Point-Bisect-Circle

3.6 PCS, Cylinder-Circle-Point

3.7 PCS, Plane-2 Line-Intersect-2 Point-Bisect-Circle

3.8 Offset Align

3.9 Pivot Align

3.10 Translate

3.11 Rotate
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Exercise 3.0, Basic Alignment

Most CMMs offer a machine coordinate system that is true to the working surface.
This allows the operator to establish simple, and fast, part coordinate system by
eliminating steps normally required to ensure accurate alignments. The following
example assumes the part orient in the Z axis is parallel to the Z axis of the CMM
and the cylinder of the Widget is pointing in the -X direction. 

Step 1

Request a -X Point feature, You will then be prompted to “Measure -X
Point”. Capture points A-1 and A-2, refer to Figure 3.0a. Note: if your sys-
tem is active for auto-direction sensing then your prompt will display
“Measure Auto-Dir Point”.

Step 2

Select Align. Note: when you elect to perform an alignment without first
establishing the orient, Geomet will assume the orient axis is parallel to
the machine coordinate system. For example, aligning in the XY plane
will force the Z axis of the MCS to establish the Z axis of the ICS.

Step 3

Select Origin. This will establish the X origin as defined by the selected
direction of the -X Point features. Note: always perform the alignment
prior to origin as the alignment will effect the probe compensation on
features such as 1D Points.

Step 4

Request a -Z Point feature, You will then be prompted to “Measure -Z
Point”. Capture point B-1.

Continued next page .....
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Step 5

Select Origin. This will establish the Z origin and your PCS Setup Guide
will now reflect that only the Y origin is still required.

Step 6

Request a +Y Point feature, You will then be prompted to “Measure +Y
Point”. Capture point C-1.

Step 7

Select Origin. This will establish the Y origin and complete the ICS to a
full part coordinate system. The PCS Setup Guide will disappear and you
are now ready to take feature measurements.

Final Inspection Report

Summary

With a minimum of four data points and four command requests admin-
istered in the proper sequence you have completed a full part coordinate
system, see figure 3.0b. This method of establishing a PCS is not meant to
work with all production parts, but it does work with parts that have a
surface that is capable of providing the orientation, or primary datum,
and can lay flat on your CMM.
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Exercise 3.1, Basic PCS Plane-Line-Point

In this exercise, we will create a basic part coordinate system utilizing a plane, line
and point for establishing the axes and origins. The following example assumes the
part is placed on your CMM where the cylinder of the Widget is pointing in the -X
direction. 

Step 1

Request a -Z plane, if auto-direction is not activated, you will be prompt-
ed for the probing direction which you should select as -Z. You will then
be prompted to “Measure -Z Plane”, (if auto-direction is active “Measure
Auto-Dir Plane”). Capture points A-1, A-2, A-3 and A-4 as shown in figure
3.1a.

Step 2

Select Orient. The orient command will create the primary datum on the
axis that is most normal to the machine coordinate system. For example,
if the plane used by orient was determined to be a XY plane then the nor-
mal will most closely align with the Z axis. In your PCS Setup Guide, the
Z Axis will be signed off.

Step 3

Select Origin. This will establish the Z origin which is determined by the
normal direction of the -Z plane.

Step 4

Request a Line feature, You will then be prompted to select the probing
direction, enter -X (if auto-direction is not active). The prompt will
update to display “Measure -X Line” (or “Measure Auto-Dir Line”).
Capture points B-1 and B-2. When the points have been captured, you
will be asked which projection plane to use, select XY. A secondary
request may be made to determine the pierce axis, select X, see Line in
chapter 4 for explanations.
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Step 5

Select Align. Your ICS will update to include the secondary datum which
is derived from the XY line feature.

Step 6

Select Origin. This will establish the X origin which is determined by the
reported direction of the XY Line.

Step 7

Request a +Y Point feature, You will then be prompted to “Measure +Y
Point”. Capture point C-1.

Step 8

Select Origin. This will establish the Y origin and complete the ICS to a
full part coordinate system. The PCS Setup Guide will disappear and you
are now ready to take feature measurements.

Final Inspection Report

Summary

The Plane-Line-Point combination of features are commonly used for
most machined parts to set the part coordinate system, see figure 3.1b. It is
important to remember that the features in these exercises are utilizing
minimum data points to achieve a complete PCS. There are several fac-
tors that can negatively effect the quality of your data points. These
include probing speed and distance between data points just to name
two.

In the case of the alignment, we used two points to calculate the line. The
repeatability of the electronic trigger probe can be as much as .00014”
with a standard 20 mm extension. If the two points for the line were
taken 0.500” apart, the possibility exists of .00028” error per inch, when
applied to the PCS effects all features being measured. It is therefor
important that you select the most stable features to establish your PCS
and balance the number of data points to help reduce inherent CMM and
operator errors. 
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Exercise 3.2, Quick PCS

In this exercise, you will utilize Geomet’s automatic part coordinate system tool, the
Quick PCS. Quick PCS requires that you have auto-direction capabilities and that it
is active through System Options⇒ Enhanced Features.

The premise of Quick PCS is to perform the basic Plane and 3 1D Points PCS setup
without the operator commanding any feature requests. When you start Geomet
and establish the working stylus, Geomet is waiting for a data point. If it acknowl-
edges an incoming data point and is not currently setup for a feature, it assumes
you are invoking the Quick PCS option.

Step 1

Using the datum targets as shown in figure 3.2a, gather data points A-1
through A-4. Geomet will automatically establish a plane, orient and ori-
gin after the forth point has been captured.

Step 2

Gather data points B-1 and B-2 making sure you follow the rules on prob-
ing 1D points using auto-direction, see Points in chapter 4. Once these two
points are captured, Geomet will establish the alignment and origin
based on the point directions.

Step 3

Capture the final data point, C-1 and Geomet will complete the final ori-
gin and establish PCS 1.
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Final Inspection Report

Summary

With the Quick PCS feature of Geomet, you were not required to press
any feature key or in any other way instruct Geomet of the next feature
or action. 

Exercise 3.3, PCS, Plane-Circle-Circle
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In this exercise, we will create a basic part coordinate system utilizing a plane and
two circles for establishing the axes and origins. The following example assumes
the part is placed on your CMM where the cylinder of the Widget is pointing in the
-X direction. 

Step 1

Request a -Z plane, if auto-direction is not activated, you will be prompt-
ed for the probing direction which you should select as -Z. You will then
be prompted to “Measure -Z Plane”, (if auto-direction is active “Measure
Auto-Dir Plane”). Capture points A-1, A-2, A-3 and A-4 as shown in figure
3.3a.

Step 2

Select Orient. The orient command will create the primary datum on the
axis that is most normal to the machine coordinate system. For example,
if the plane used by orient was determined to be a XY plane then the nor-
mal will most closely align with the Z axis. In your PCS Setup Guide, the
Z Axis will be signed off.

Step 3

Select Origin. This will establish the Z origin which is determined by the
normal direction of the -Z plane.

Step 4

Select Circle, if auto-direction is not activated, you will be prompted for
the Circle type, ID OD IR OR, choose ID. Capture the four data points
identified as B-ID/4, see figure 3.3a. Continue with the data points for the
next circle, C-ID/4.

Step 5
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Select Align. Your ICS will update to include the secondary datum which
is derived from the two XY circles. The alignment takes place through the
reported XY position of the circles which are projected into the orient
plane.

Step 6

Select Origin. Circles, which are 2D, provide two directions when estab-
lishing an origin. In our example, the circle can be used for the X and/or
the Y directions. The origin command will prompt you whether to use
the X and then the Y. For our example you should answer Yes to both
requests. Upon completion, you will have established PCS 1.

Final Inspection Report

Summary

In this exercise, we utilized two coplanar XY features for the alignment
and subsequent origin. As with many feature characteristics, the circles
could have been replaced with any feature that reports a 2D solution.
These include 2D points, cylinder and cone pierce points, etc.

Through the proper selection of features, you can establish a part coordi-
nate on nearly any type of manufactured part.

Exercise 3.4, PCS, Plane-Cylinder-Circle
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In this exercise, we will create a part coordinate system utilizing a plane for the ori-
ent and origin, a cylinder for the alignment followed by a circle for the last compo-
nents of the origin. The following example assumes the part is placed on your
CMM where the cylinder of the Widget is pointing in the -X direction. 

Step 1

Request a -Z plane, if auto-direction is not activated, you will be prompt-
ed for the probing direction which you should select as -Z. You will then
be prompted to “Measure -Z Plane”, (if auto-direction is active “Measure
Auto-Dir Plane”). Capture points A-1, A-2, A-3 and A-4 as shown in figure
3.4a.

Step 2

Select Orient. The orient command will create the primary datum on the
axis that is most normal to the machine coordinate system.  In your PCS
Setup Guide, the Z Axis will be signed off.

Step 3

Select Origin. This will establish the Z origin which is determined by the
normal direction of the -Z plane.

Step 4

Select Cylinder, if auto-direction is not activated, you will be prompted
for the cylinder type, ID OD IR OR, choose OD. Capture the six data
points identified as B-OD/6, see figure 3.4a. 

Step 5
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Select Align. A cylinder offers the possibility of more than one alignment
solution. In our example, you have solved the Z
axis orient by utilizing the previous plane, there-
fore you are attempting to align the remaining
axis, or XY. Select the XY button from the Select
Axis dialog, see figure 2.34c. 

Your ICS will now update to include the sec-
ondary datum which is derived from the longi-
tudinal axis of the cylinder. In this example, the
cylinder was reported as piercing the YZ ICS
base plane, therefore the normal to that plane is
X with a direction of -X. The PCS Setup Guide
will update to reflect the XY Axis have been
solved.

Step 6

Select Circle, if auto-direction is not activated, you will be prompted for
the Circle type, ID OD IR OR, choose ID. Capture the four data points
identified as C-ID/4, see figure 3.4a.

Step 7

Select Origin. the Circle, which is 2D, provide two directions when estab-
lishing an origin. In our example, the circle can be used for the X and/or
the Y direction. The origin command will prompt you whether to use the
X and then the Y. For our example you should answer Yes to both
requests. Upon completion, you will have established PCS 1, see figure
3.4b.

Final Inspection Report
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Summary

There are times when you are required to utilize more than one 3D fea-
ture to solve for the part coordinate system. In this example we used a
3D feature, a cylinder, from which the alignment is derived, therefore you
are prompted to solve which part coordinate system component to solve.

From this example you should note that the data point spread on the
cylinder is approximately 1.25”in the X axis and the width of the part is
4.50”. This can be a cause of concern as it is poor inspection practice to
have your data point spread ratio to the width of the part less than 50%,
in this case only 28%. The possibility of skewing your part coordinate
system increases dramatically as your ratio is reduced.

However, conditions do arise that do not allow for proper setup and as
the inspector, you are challenged to determine the best data point spreads
with the features available that will produce a sound part coordinate sys-
tem.

Exercise 3.5, PCS, Plane-Point-Point-Bisect-Circle
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In this exercise, we will create a part coordinate system utilizing a plane for the ori-
ent and origin, two 2D points from which we will obtain a constructed 2D point
through the bisect command then followed by a circle for alignment and origin.
The following example assumes the part is placed on your CMM where the cylin-
der of the Widget is pointing in the -X direction. 

Step 1

Request a -Z plane, if auto-direction is not activated, you will be prompt-
ed for the probing direction which you should select as -Z. You will then
be prompted to “Measure -Z Plane”, (if auto-direction is active “Measure
Auto-Dir Plane”). Capture points A-1, A-2, A-3 and A-4 as shown in figure
3.5a.

Step 2

Select Orient. The orient command will create the primary datum on the
axis that is most normal to the machine coordinate system.  In your PCS
Setup Guide, the Z Axis will be signed off.

Step 3

Select Origin. This will establish the Z origin which is determined by the
normal direction of the -Z plane.

Step 4

Select a 2D XY Point. The selection of a 2D point requires two commands.
The first command is activated by pressing the
< 5 > key, 2D and 3D point selection, which will
then prompt which current base plane you will
project into, see figure 3.5c.

After the selection has been completed, Geomet
will prompt you to “Measure XY Point”.
Capture points B-1 and C-1.

Step 5

Select the Bisect command. This command will
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take the two projected XY points and solve for the bisect between them.
The result will be a 2D XY point.

Step 6

Select Circle, if auto-direction is not activated, you will be prompted for
the Circle type, ID OD IR OR, choose ID. Capture the four data points
identified as D-ID/4, see figure 3.5a.

Step 7

Select Align. Your ICS will update to include the secondary datum which
is derived from the XY circle and the previous XY point. 

Step 8

Select Origin. the Circle, which is 2D, provide two directions when estab-
lishing an origin. In our example, the circle can be used for the X and/or
the Y direction. The origin command will prompt you whether to use the
X and then the Y. For our example you should answer Yes to both
requests. Upon completion, you will have established PCS 1, see figure
3.5b.

Final Inspection Report

Summary
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In this exercise, we used a constructed feature, an XY point, as part of the
alignment solution. It is important that you choose the correct features to
be used for alignment based on the completeness of the ICS. The XY
points for B-1 and C-1 were chosen as the ICS lacked an alignment. If two
1D points were chosen, then there would exist an error caused by the
part skewed to the MCS base axis.

This does not preclude conditions where 1D points could have been
used. For example, if we were working in the PCS that was created in
exercise 3.1, then we would have the correct probe compensation vector
and we could select -X and +X 1D points for
B-1 and C-1 respectively. The resulting bisect
would create a 1D point on the centerline of
the slot.

However, a 1D point followed by a circle can
not be combined to form an alignment.
Geomet does not accept this as it causes
potential repeatability problems when the
slot is not aligned with the current PCS.
Therefore you could repeat the bisect of two additional 1D points cap-
tured on the width of the part at the other end from the slot, see
figure3.5d. The resulting 1D point derived from the bisect combined with
the previous recalled constructed point could produce the alignment.

Exercise 3.6,PCS, Cylinder-Circle-Point
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In this exercise we will utilize a cylinder to provide the primary datum and the
pierce point from the cylinder as the origin. The alignment will be supplied
through a circle and the previous cylinder. Finally a 1D point will complete the part
coordinate system by providing the last component of the origin. The following
example assumes the part is placed on your CMM where the cylinder of the Widget
is pointing in the -X direction. 

Step 1

Select Cylinder, if auto-direction is not activated, you will be prompted
for the cylinder type, ID OD IR OR, choose ID. Capture the six data
points identified as A-ID/6, see figure 3.6a.

Step 2

Select Orient. The orient command will create the primary datum on the
axis of the cylinder that is most parallel to the machine coordinate sys-
tem.  In your PCS Setup Guide, the Z Axis will be signed off.

Step 3

Select Origin. This will establish the origin reported as the pierce point of
the cylinder. In this example, the cylinder pierces the XY base plane and
the origin command will prompt you whether or not to set the origin on
the X and/or the Y. Answer yes to establish the XY origin.

Step 4

Select Circle, if auto-direction is not activated, you will be prompted for
the Circle type, ID OD IR OR, choose ID. Capture the four data points
identified as B-ID/4, see figure 3.6a.

Step 5

Select Align. Your ICS will update to include the secondary datum which
is derived from the XY circle and the previous XY pierce point from the
cylinder.

Step 6
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Select -Z Point. The final component missing for your complete PCS is
the Z origin. You will then be prompted to “Measure -Z Point”. Capture
point C-1.

Step 7

Select Origin. Your ICS will now be completed and establishes as a part
coordinate system, see figure 3.6b.

Final Inspection Report

Summary

When using a through bore as the primary datum, we must be careful
that the data point spread is sufficient to allow for a stable feature. In the
example we would place an extension on the stylus to allow for a greater
reach into the cylinder.

Exercise 3.7, PCS, Plane-2 Line-Intersect-2 Point-Bisect-Circle
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In this exercise we will combine two constructed features to create the secondary
datum. These constructed features are derived from two lines intersected and two
2D point bisected. The following example assumes the part is placed on your CMM
where the cylinder of the Widget is pointing in the -X direction.

Step 1

Request a -Z plane, if auto-direction is not activated, you will be prompt-
ed for the probing direction which you should select as -Z. You will then
be prompted to “Measure -Z Plane”, (if auto-direction is active “Measure
Auto-Dir Plane”). Capture points A-1, A-2, A-3 and A-4 as shown in figure
3.7a.

Step 2

Select Orient. The orient command will create the primary datum on the
axis that is most normal to the machine coordinate system.  In your PCS
Setup Guide, the Z Axis will be signed off.

Step 3

Select Origin. This will establish the Z origin which is determined by the
normal direction of the -Z plane.

Step 4

Request a Line feature, You will then be prompted to select the probing
direction, enter -X (if auto-direction is not active). The prompt will
update to display “Measure -X Line” (or “Measure Auto-Dir Line”).
Capture points B-1 and B-2. When the points have been captured, you
will be asked which projection plane to use, select XY. A secondary
request may be made to determine the pierce axis, select X, see Line in
chapter 4 for explanations.

Step 5
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Clear the current mode by pressing the < Esc > key. Request a Line fea-
ture, You will then be prompted to select the probing direction, enter +X
(if auto-direction is not active). The prompt will update to display
“Measure +X Line” (or “Measure Auto-Dir Line”). Capture points C-1
and C-2. When the points have been captured, you will be asked which
projection plane to use, select XY. 

Step 6

Select the Intersect command. This command will take the two projected
lines and solve for the intersect between them. The result will be a 2D XY
point.

Step 7

Select a 2D XY Point. The selection of a 2D point requires two commands.
The first command is activated by pressing the
< 5 > key, 2D and 3D point selection, which will
then prompt which current base plane you will
project into, see figure 3.7c.

After the selection has been completed, Geomet
will prompt you to “Measure XY Point”.
Capture points D-1 and E-1.

Step 8

Select the Bisect command. This command will
take the two projected XY points and solve for the bisect between them
resulting in a 2D XY point.

Step 9

Select in the report feature number 7 (2D point formed by the intersect
command). Right-click your mouse and select Recall Feature. This will
recall the feature to new feature number 11.

Step 10

Select Align. Your ICS will update to include the secondary datum which
is derived from the recalled 2D XY point and the previous 2D XY point
created from the bisect. 

Step 11

Select Circle, if auto-direction is not activated, you will be prompted for
the Circle type, ID OD IR OR, choose ID. Capture the four data points
identified as F-ID/4, see figure 3.7a.

Step 12
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Select Origin. the Circle, which is 2D, provide two directions when estab-
lishing an origin. In our example, the circle can be used for the X and/or
the Y direction. The origin command will prompt you whether to use the
X and then the Y. For our example you should answer Yes to both
requests. Upon completion, you will have established PCS 1, see figure
3.7b.

Final Inspection Report

Summary

In this exercise we had combined features to create constructed features
which are then used to create part coordinate system components. In part
production we will find numerous cases where one or more part coordi-
nate system datums are symmetry lines or points where no features exist.

When performing constructions in a ICS, it is important to remember the
established projection base planes that are valid. For example, in this
exercise it would not have produced acceptable results if we established 2
ZX point, one each on the top and bottom surfaces of the widget and
then performing the bisect. The resulting 2D point would be projected
into the alignment of the machine coordinate system and therefore would
not represent a valid point feature for the part coordinate system.

Exercise 3.8, Offset Align
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In this exercise we will perform an offset alignment to create a secondary datum.
The offset align function performs a realignment of an existing part coordinate sys-
tem. As you must have a complete coordinate system defined, please setup your
part described in exercise 3.4.

! If you do not have the Advanced PCS and Stylus Option, you have access to only
one PCS at any point of your inspection. By performing the offset align command,
you will realign the existing PCS 1 and will not be able to revert back to the original
part coordinate system. If you have the Advanced PCS and Stylus option, the offset
command will create PCS 2.

Step 1

From the established PCS as defined in exercise 3.4, recall feature number
6 ID XY Circle. We perform this step in preparation of the realignment.
The offset align required two features which both must be in the same
PCS and stacked together in the report, see recalling features chapter 5.

Step 2

Select Circle, if auto-direction is not activated, you will be prompted for
the Circle type, ID OD IR OR, choose ID. Capture the four data points
identified as A-ID/4, see figure 3.8a.

Step 3

Select Offset Align, press < ⇑ > + < K >. Note if you do not have the
Advanced PCS and Stylus option, you will be
prompted whether to realign PCS 1 or cancel,
select < Ok >. A request will be displayed where
you enter your offset value. Enter .70711 and
press < Accept >.

This will realign the current PCS to the plus (+)
side of the last feature. A negative (-) will realign
to the left side of the feature. The value you enter
controls the realignment direction based on the
sign of the value.
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Exercise 3.9, Pivot Align

In this exercise we will perform a realignment of the current PCS by pivoting
around the origin through the last measured or recalled feature.The pivot function
performs a realignment of an existing part coordinate system. As you must have a
complete coordinate system defined, please setup your part described in exercise
3.4.

! If you do not have the Advanced PCS and Stylus Option, you have access to only
one PCS at any point of your inspection. By performing the pivot command, you
will realign the existing PCS 1 and will not be able to revert back to the original
part coordinate system. If you have the Advanced PCS and Stylus option, the offset
command will create PCS 2.

Step 1

Select Circle, if auto-direction is not activated, you will be prompted for
the Circle type, ID OD IR OR, choose ID. Capture the four data points
identified as A-ID/4, see figure 3.9a.

Step 2

Select the Pivot command, press < Ctrl > + < k >. Note if you do not have
the Advanced PCS and Stylus option, you will be prompted whether to
realign PCS 1 or cancel, select < Ok >. The current PCS will realign
through the last feature.

Summary

In this exercise, we choose to realign by pivoting though a feature that
lies at 45° to the current PCS. This can cause unexpected results during
part program runs. For example, if the feature was at 44.99° from the X
axis during self-teach it would realign by rotating counter-clockwise
44.99° about the Z axis. However, if during self-teach the feature was
45.01° the realignment would take place by rotating 44.99° clockwise
causing a 90° shift in the expected PCS.

We recommend that caution should be taken where unexpected results
can occur as is the case of any 45° rotations or pivots.
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3.10, Translate

In this exercise we will take an existing part coordinate system and translate it by
nominal amounts in the X and Y axis. The translate command can be performed on
X, Y and/or Z individually or any combination. As you must have a complete coor-
dinate system defined, please setup your part described in exercise 3.1.

Step 1

Select the Translate command.
When you activate this command,
Geomet will display a dialog where
you can enter your translation val-
ues, see figure 3.10c. Enter 2.125 for X
and 1.500 for Y and no entry for Z.
Preform the translation by pressing
the < Accept > button.

A new PCS will be established, or in
the case of base Junior, a translation
of the current PCS takes place.

Summary

In many conditions, it is required to translate the part coordinate system
when you are working with a datum that is derived from points that are
not defined on your part. For example you may be inspecting a cavity
insert which was removed from a progressive die where the datums are a
common alignment pin not available at inspection time. Another example
is the focal point of a optical lens whose surface radial may be projected
2,000” from the actual part.
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Exercise 3.11, Rotate

In this exercise we will take an existing part coordinate system and rotate it about
an axis by a nominal value. The rotate command can be perform only about one
PCS axis at a time. If you require to perform compound rotations, the rotate com-
mand will be repeated. As you must have a complete coordinate system defined,
please setup your part described in exercise 3.1.

Step 1

Select the Rotate command, press < ⇑ >
+ < : >. When you select this command,
a Rotate PCS AXis dialog will prompt
you to enter a nominal value for a axis,
see figure 3.11c. This dialog will ensure
you enter only one value prior to
accepting the nominal value. For this
exercise, enter -5 in the X axis control
and press the < Accept > button.

A new PCS will be established, or in the
case of base Junior, a translation of the
current PCS takes place.

Summary

To verify that we performed the rotation correct, select a -Z Point feature
and probe the top surface of the 5° plane located on the tapered end of
the Widget. We should see a -Z point value  at .018 ± .005.
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Basics in Feature Measurement
Reviewing a few concepts in plane and solid geometry will help immensely in
implementing your Geomet system. It is important to develop a feeling for 3D spa-
tial elements such as lines, planes, cylinders, etc., and for their spatial relationships.
Understanding the concept of the coordinate system and its elements is absolutely
essential.

1D Point

1D Points have 1D locations. There are 6 1D point routines, designated
±X, ±Y and ±Z. Pressing one of these keys prepares Geomet to measure a
single point of a planar surface, followed by a printout of the location of
the center of the stylus corrected by the stylus radius in the PCS probing
direction. Problems arise if the planar surface is not parallel to a PCS base
plane.

Figures 4.1a and 4.1b, illustrate a 1D point measurement of one and the
same planar surfaces prior to alignment (MCS) and after alignment (PCS
2).

Although the stylus center is at the same XYZ location in both cases, the
calculated points P1 and P2 are quite different. P1 resulted from a probe
radius correction parallel to the X axis of the MCS. P2 resulted from a
probe radius correction parallel to the X axis of PCS 2. This illustrates
how measurements of a surface in an unaligned PCS can produce erro-
neous results.

Single 1D Point measurements can only be used to determine the locations of pla-
nar surfaces which are parallel to the PCS planes.

Pairs of 1D Point measurements on planar surfaces which are parallel to PCS
planes may serve to determine the Distance between the surfaces or the location of
the Bisector of surfaces.

Pairs of 1D Point measurements on simply skewed planar surfaces, meaningless in
themselves, may be used to define a Line on a surface or to Align the current PCS
to be parallel to the surface.
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Single and multiple 1D Point measurements on compound skewed plane or curved
surfaces provide meaningless data.

To measure a 1D Point, press the corresponding Point direction key and gather a
data point on your work piece. If you have Auto-Direction enabled, you will be
prompted “Measure Auto-Dir Point” and your approach vector to the work piece
will identify the probing vector.

Using Auto-Direction

Using auto direction on 1D Points can lead to erroneous reported values if used
incorrectly. Auto direction relies on a smooth approach, from you the operator, in
capturing of a data point. The process of
determining the approach vector involves the
CMM interface card (ProCounter, Tech 80 or
PMAC) to maintain a rolling IJK vector based
on the last five reported values. These inter-
face cards update the current position in the
MCS on a programmable time interval from
20 to 200 milli-seconds.

When you are approaching your work
piece, it is required that you make contact
while remaining in a ±45° approach, see figure
4.1c. In this example, if we remained in the
approach zone we will capture a data point
that will be reported as a +Y point. If the operator did not remain in the approach
zone the 1D Point will report as a ± X Point from which we will have to correct the
probe compensation error. Most common occur-
ance of a erroneous data point comes from opera-
tors who approach the surface, and then pause
the approach and attempt to make contact under
extremely slow speeds, which while approaching
causes variations in the path toward the surface.

To correct the reported direction of a 1D
Point, highlight the feature by left-clicking on it,
then right-click to bring up the feature menu, as
shown in figure 4.1d. Select [Point Direction] which
will offer a sub-menu with all six probing direc-
tions available. Choose the correct 1D Point direction and your part inspection will
update with the correct 1D Point.

Note: Once a feature has been referenced it can not be changed or edited. For exam-
ple, if a feature was used in the construction of a PCS , it will be locked from changes. This
is identified by the inclusion of a ¹ next to the feature number, example “ 12¹ “.

2D Point
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The 2D Point function is normally used in conjunction with a hard taper
probe for simple contact determination of the location of bores whose
axes are parallel to the PCS Z axis. It can also be used with hard ball sty-
lus for single contact determination of the location of bores whose axes
are parallel to any PCS axis. In these applications the 2D Point feature is
referred to as the self-centering routine. The 2D Point feature can also be
used with hard or electronic trigger ball stylus to create 2D Bisector Point
features in slots or a web for Aligning purposes as shown in Exercise 3.5
in chapter 3. All 2D Points are automatically projected into PCS base
planes.

To measure a 2D Point press the 2D Point key, < 5 > from the number pad. Geomet
will prompt you for a PCS base plane the 2D Point will project into, see number pad
iconic view above. Choose XY, YZ or ZX and begin your measurement.

3D Point

The 3D Point feature reports the current PCS location of the center of the
ball stylus used in the measurement. It is useful in conjunction with a
hard ball stylus to establish a point on the axis of an ID cone. An example
is to establish the centerline of a turned part using two 3D Points, one at
each end in the conical shaped turning datums used by the head and tail
stock.

To measure 3D Point Features, press the 3D Point key, < 5 > from the
number pad. Choose 3D, see number pad iconic view above and begin your
measurement.

IR/OR Point

The IR (Inside Radial) and OR (Outside Radial) Point features allows 2D
and 3D, ball radius compensated probing of cylindrical and spherical
surfaces. The probe vector is determined as a vector from the current PCS
origin through the ball center of the stylus. Inside Radial features are
compensated by adding one radius along
this vector, Outside Radial subtracts one
probe radius, see figure 4.2a.

These features are ideal for measuring
extremely large radial surfaces that only
offer a small segment to capture data
points on. Translate your PCS origin to the
centroid of the feature and capture radial
points along the surface.
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Line

The Line feature provides you with the means to measure 2D Lines. 2D
lines are projected into a PCS base plane and report the angular deviation
from and 1D pierce value of a PCS base axes. The line feature is a multi-
point of 2 - 32767 data points.

The determination of the PCS base plane is supplied by the operator after
the capturing of the data points, see figure 4.3a. Depending on the angle of
the line, Geomet will prompt for the selection of a PCS axis to report, see
figure 4.3b. Geomet uses an angle of ± 10° between the line normal to a
PCS axis to determine if the
operator should be prompted to
select the pierce axis.

For example, if a line being measured
crosses the PCS X axis at 1.000” and has a
reported angle of 85°, the operator will not
be prompted to select a PCS axis. The the
same line had a reported angle of 75°, then
Geomet would prompt the operator to
select the pierce axis showing the solutions
of both values as shown in figure 4.3b.

After completing the first measured line, Geomet auto-cycles preparing to measure
another line. Note: during auto-cycle, Geomet will not prompt you for a projection
plane. It is assumed continuing measuring lines in the original selected plane.

The direction of the line is determined by the direction of the data points, from the
first data point to the second. In figure 4.3c, the data points were gathered created a
reported angle of 30° whereas in figure 4.3d, the reported angle is -150° for the
same feature.

Multi-Point Line features. The default number of points used for line measurements
is controlled by the value in System Options. If you require a different value hold
the < ⇑ > + < M >, then you will be prompted for the number of data points.
Another method is to press the line key repeatedly and the count will increase by
one with every repeat. This method can be used even while some data points have
already been captured.
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Circle

The Circle feature determines the center location and diameter or radius
of bores and bosses whose axes are parallel to a PCS axis. The circle fea-
ture will give erroneous results on skewed bores and bosses. The circle
locations on circles are projected into a PCS base plane, see figure 4.4c, and
are 2D in nature.

To measure bores or bosses, press the Circle key < z >
for the default number of data points as set in System
Options. Geomet will then prompt you for the type of
feature being measured, see figure 4.4a. If you have Auto-
direction enabled, this prompt will not appear.

If you required additional data points, you can repeated-
ly press the Circle key which increments the required
number by one, or hold press < ⇑ > + < Z > and you will
be prompted to enter the required number.

Geomet performs a form validation on your gathered
data points. This function is called the Multi-Point Error Limit and is controlled by a
setting in System Options. In the event your circle exceeds this limit, Geomet will
prompt you whether to accept or re-measure the feature, see figure 4.4b. If you elect
< Re-Measure >, you will be prompted to capture new data points for the same fea-
ture. Note: The Multi-Point Error Limit
test is only performed in the self-teach
mode, not during a part program run.

Data points used to calculate a circle if
not spread around the circle can cause
erroneous results. In the table below,
we will use a 3 point circle with one
point .00014” off the nominal value for
a 1.00” radius. The results are calculat-
ed to show the error that is part of the
reported values.

Arc Center Radius
180° .00014 .00000
120° .00028 .00014
90° .00048 .00034
60° .00104 .00090
30° .00409 .00395
20° .00914 .00899
10° .03549 .03535
5° .12823 .12810

As shown above, the center location
and radius degrades dramatically as
your data points are taken over a
smaller sweep.

n auto

figure 4.4a, Circle type

figure 4.4b, Form Error Limit

figure 4.4c Circle Projection
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Plane

Planes have locations, attitudes and directions. The location of a plane is
defined as the point at which it is pierced by a PCS axis. The attitude of a
plane is defined by the projection angle AX/Y, AY/Z and AZ/X of the
plane normal in each of the three PCS base planes, with range values
from 0° to ± 180°.

The direction of a plane is defined
as that of the normal, pointing out
of the solid. Figure 4.5a shows a
plane with its projection into each
PCS base plane. The normal, when
projected into each PCS base plane
provides the attitude in angles, see
figures 4.5b, 4.5c, 4.5d.

The Plane feature may be used to measure
non-skewed planes. The printed pierce point
of a measured plane is determined by the PCS
axis that is most parallel to the normal of the
measured plane. In the example in figure 4.5a,
the pierce point would be report as a Z axis point.

Planes which are essentially parallel to PCS base planes have only two attitude
angles which are meaningful, the third is printed in lower case, as for example
“ax/y” to indicate its reduced significance.

To measure Planes press the Plane key for a 4 point (or the default as established in
System Options) plane, or < ⇑ > + < B > for a multi-point plane. If auto-direction is
not enabled, you will be prompted to enter the probing direction. Upon completion
of gathering your data points, Geomet will test the form error to the newly calculat-
ed plane. If the form error exceeds the default setting, you will be prompted to <
Accept > or < Re-Meas > the plane.

n
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figure 4.5a, Plane Projection

figure 4.5b AX/Y Projection figure 4.5b AY/Z Projection figure 4.5b AZ/X Projection



Basic in Feature Measurements: 4-7Helmel Engineering Products, Inc.

Cylinder

The cylinder feature determines the diameter, PCS pierce point and atti-
tude of the axis of bores and bosses. The attitude of a cylinder axis is
expressed like the attitude of the normal of a plane, using the characteris-
tic identifiers AX/Y, AY/Z and AZ/X, see figure 4.6b. These angles can
vary between 0° and ± 180°. The axis of a
cylinder has a direction as well as an attitude:
its direction is from the first group of points at
one end to the group of points measured at
the other end.

The reporting of the position in the PCS is the point
where the axis of the cylinder intersects a PCS base
plane, called the pierce point. Geomet determines which
PCS base plane to report by determining which PCS
base plane the axis of the cylinder is most normal to, see
figure 4.6b.

To measure bores or bosses press the Cylinder key for an 6 point (or the default as
established in System Options) cylinder, or < ⇑ > + < C > for a multi-point cylinder.
If auto-direction is not enabled,
Geomet will prompt you for the
type of cylinder as shown in figure
4.6a. After the data points have been
captured, Geomet will test the form
error and if exceeded, will prompt
you to < Accept > or < Re-Meas >. 

n auto

figure 4.6a, Cylinder type

figure 4.6b, Cylinder Pierce Point and Attitudes



Sphere

The Sphere feature provides the diameter and 3D location of the center of
the sphere.

To measure a sphere4, press the Sphere key for a 5 point (or the default as estab-
lished in System Options) sphere, or < ⇑ > + < V > for a multi-point sphere. If auto-
direction is not enabled, Geomet will prompt you for the
type of sphere as shown in figure 4.7a. After the data
points have been captured, Geomet will test the form
error and if exceed, will prompt you to < Accept > or <
Re-Meas >. 

Cone

The Cone feature determines the included
angle, the PCS pierce point and attitude of the
axis and the diameter of the cone at the pierce
point. The attitude of the cone axis resembles the axis of a cylinder in the
projection characteristics, see figure 4.6b.

To measure Cones, press the Cone key for a 7 point (or the default as established in
System Options) cone, or < ⇑ > + < N > for a multi-point cone. If auto-direction is
not enabled, Geomet will prompt you for the type of sphere as shown in figure 4.7a.
After the data points have been captured, Geomet will test the form error and if
exceeded, will prompt you to < Accept > or < Re-Meas >. 

Cone Diameter

Geomet provides a unique function that
allows you to retrieve the diameter of a cone
at a specific distance from the PCS base
plane along the axis of the cone. To request
the diameter command, right-click on the
cone in the report and a sub-menu will
appear, see figure 4.7d, choose [Cone
Diameter]. Enter the offset value in the dia-

log, see figure 4.7b, and press the < Accept > button.

Cone Offset

To obtain the offset distance from the PCS base plane of a
specific diameter along the axis of a cone, start by right-
clicking on the cone feature and choose from the sub-menu
[Cone Offset], see figure 4.7d. Enter the diameter nominal in
the dialog, see figure 4.7c, and press the < Accept > button.
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Digitized Point Cloud

The surface digitizing feature provides the means to gather large
amounts of data on your work piece. The point data captured is the ball
center locations of each data point. Geomet will report the feature as a
“Digitized Point Cloud” from has no reported values nor can construc-
tions be performed with this data.

To perform a digitize function, select the surface key, < / > and begin gathering
your data points. To complete the capturing of data, press the Terminate key < F5 >.
This data can be exported either as DXF or ASCII data points.
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Actions and Feature Construction
Through the use of the Construction tools, you can create features from commands
such as Bisector and Intersect. Construction tools also provide feature-to-feature
relationships as found in Distances and Angles.

Actions are features within Geomet that provide User Prompts, Text statements and
feature state changes.

Text Features

Text

The Text feature < y >, permits
comments to be written to your
part inspection report. These text
statements are written during
the self-teach mode are copied to
the report during part program
auto-cycle (auto-cycle requires
that you have the Programming
option active), see figure 5.1a.

User Prompt

The User Prompt feature, < ⇑ > +
< Y >, provides an interrupt dur-
ing a program auto-cycle.

During the self-teach mode, you can pro-
vide instructional statements such as a
reminder to rotate a manual indexing
probe to a new location or to insert a
thread gage prior to measuring its location.
When the part programming is advancing
to a User Prompt, a message will flash on
the monitor and pause further execution
until the operator acknowledges by press-
ing the < Accept > button. The User Prompt requires that you have the
Programming option active. If the Programming option is not active, then this fea-
tures has the same behavioral characteristics of the text feature.
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Inline Text Entry

The Inline Text Entry feature, <
Alt > + < y >, provides a inter-
rupt during a program auto-

cycle to allow current text statements to be
added. During self-teach, you add a
request to enter data. An example would
be to add the statement “Enter condition of
part. Dirt, oil, etc.”. Then during the auto-
cycle when this feature is executed, the
operator will enter the request and these
new comments become part of the inspec-
tion report.

Inline Text Entry requires that you have the Programming option active. If the
Programming option is not active, then this features has the same behavioral char-
acteristics of the Text feature.

Feature Editing

Feature editing can be accomplished as a post operation once the feature has
already been reported. These changes fall into different categories of universal state
changes and feature specific changes.

Universal State Changes - Single Feature

Universal changes are those that can be applied to any measured or constructed
features these include:

•Inch/Metric •Cartesian/Polar
•Brief/Full Reporting
•Degree.Decimal/Degree-Minutes-Seconds

To make these changes to a specific feature on the
report, left-click with your mouse on the feature
which will highlight the entire feature. Right-click
to activate the feature sub-menu, see figure 5.2a.

Choose [Feature Characteristics] and a pop-out
menu appears offering the current states of the
selected feature. Choose the change you want to
implement, and your feature will be updated by
selecting the new state.
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Universal State Changes - Multiple Features

Geomet allows you to update several features at one time using your mouse to
interact with the report. In the example above, you were showed how to make a
state change to just one feature. To perform the same state change to several fea-
tures by using the < ⇑ > and the < Ctrl > keys.

To highlight a continuous range of features, start by left-clicking on the first feature,
then hold down the < ⇑ > key and left-click on the last feature of the range. All fea-
ture in between the first and last feature will highlight. To selectively add one fea-
ture at a time, hold down the < Ctrl > key and left-click on the selected feature.
Now follow the instructions above to change the states of all selected features.

Feature Edits - 1D Point

When you have auto-direction active, 1D Points
can be mis-reported. This is normally caused by
poor probe approach vectors to the surface of the
part, see 1D Points in Chapter 4.

To change the reported direction of a 1D Point,
start by highlighting the feature in the report and
then right-click to activate the feature menu.
Choose [ Point Direction] and select the new direc-
tion.

This can only be applied to 1D Point features that
are not currently referenced by other actions such as PCS components, recalls and
distances.

Feature Edits - Labels

Geomet identifies each feature with standard
default nomenclature. In the case of a 1D Point,
the default is to report the probing direction plus
“Point”, example “-Z Point”. 

To help identify your features by using plain text,
highlight the feature in the report and activate the
feature sub-menu. Choose the command [Attach
Feature Label] and you will be prompted to enter a
feature label, see figure 5.4. This same procedure is used to edit or remove an exist-
ing label by choosing < Remove > or editing the label and pressing < OK > .

Feature (un)Delete

To delete a feature in your inspection report, highlight the feature, as described
above, and select [(un)Delete]. This will remove the feature from your report and
replace it with “Deleted”. To undelete a feature that has previously been deleted,
highlight the feature and select [(un)Delete].
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Printing Selected Items

Geomet Junior allows selective printing of features
through the use of the feature sub-menu. see figure 5.5.
Highlight the features to be included in the report, right-
click to bring up the feature sub-menu and activate the
command [Print Selected Items].

Distance 

The Distance command determines the positive or negative point-to-
point distance between the last two features in the report stack. The
Distance command reports only the common axis between the features.
For example: a XY Point and a 1D X Point share the X axis.

To perform a distance, measure, construct or recall the desired features and press
the Distance key < s >. Geomet will validate the two features and identify the com-
mon axis, then perform the distance calculation. The sign of the reported distance is
taken from the last feature to the previous feature.

A basic understanding on how dis-
tance is calculated will help to elimi-
nate erroneous results. For example;
the distance reported two planes is
the distance where each plane cross-
es the current PCS base axis, see fig-
ure 5.6. Erroneous distances can be
reported when the planes are locat-
ed at a distance to their report PCS
pierce axis. In our experiment, we
used two planes where one plane
(upper) is skewed by 1 minute to
the opposite plane (lower). 

In this example PL1 and PL2 report
a distance directly representative to
the expected distance between the planes because the PCS axis is piercing the area
the data points from the planes were gathered.

In PL2 and PL3 the data points used for the calculation of the planes were 5” from
the PCS axis and with just a 1 minute skew between the planes, the reported dis-
tance is .0016” in error. Applied to PL5 and PL6, whose data points were gathered
10” from the PCS axis, the 1 minute difference causes .0032” error.
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Angles

The Angle feature determines the angles between the last two features on
the report stack. Angles are returned on two 2D lines that are coplanar, a
2D line and a 3D axial feature and 3D axial features.

When applying the Angle
command between two 3D
axial features such as plane,
cylinders, 3D lines and
cones. The reported angle is
user selectable through the
feature sub-menu for theta
(included angle), or the PCS
base plane projection angles
defined as AX/Y, AY/Z and
AZ/X, see figure 5.7.

Intersection

The Intersection feature determines the characteristics if the intersection
of the last two features on the report stack. Intersections can be accom-
plished with the following combinations:

Feature 1 Feature 2 Notes:
2D Line 2D Line Must be coplanar
Circle Circle Must be coplanar
Line Circle Must be coplanar
Plane Plane Creates a 3D line with 2D pierce point
Plane Cylinder Creates a 3D point
Plane Cone Creates a 3D point
Cylinder Cylinder Creates a user defined 3D point and miss distance
Cylinder Cone Creates a user defined 3D point and miss distance

An example of a circle/line intersection have three possibilities where the line pass-
es through the circle, line misses the circle or the line is tangent to the circle. In fig-
ures 5.8a and5.8b, Geomet prompts you to select which point should be reported.
The values reported on the buttons are the actual reported PCS values.

An example of two 3D axial features intersecting is shown if figure 5.8c where the
closest line of approach is reported as end points and a mid point.
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Bisector

The Bisector feature determines the bisecting or symmetry feature
between the last two features on the report stack. Bisector can create two
possible solutions, when this occurs Geomet prompts for the operator to
select one, see figure 5.9a and 5.9b.

Feature 1 Feature 2 Notes:
1D Point 1D Point Creates a 1D Point
2D Point 2D Point Creates a 2D Point, Must be coplanar
3D Point 3D Point Creates a 3D Point
2D Point 3D Point Creates a 3D Point
Plane Plane Creates a Plane
Line Line Creates a Line
Sphere Sphere Creates a 3D Point
Cylinder Cylinder Creates a user defined 3D point or 3D Line
Cylinder Cone Creates a user defined 3D point or 3D Line
Cone Cone Creates a user defined 3D point or 3D Line
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Constructions

Geomet Junior provides construction tools to create Lines, Circles and
Planes from the previous ‘x’ number of features on the report stack.
These created features can be used in constructions and relationships
similar to those applied to measured features.

When you press the Fit key < g >, Geomet prompts you with a feature selection
dialog, see figure 5.10a, select the feature to create and press
the < Enter > key. Geomet will now prompt you for the
number of features to use in the construction starting with
the last feature and continues looking back through the
report until the correct number of features have been used.
Geomet provides safeties to prevent entering a number of
features to be less than the minumum required to construct
the feature.

Fit Line

The Fit Line feature permits the creation of a line fitted
through a set of previously measured or constructed fea-
tures. These features can be a combination of codirectional
1D points, and/or 2D coplanar points.

Fit Circle

The Fit Circle feature permits the creation of a circle fitted through a set of previ-
ously measured or constructed features. These features can be a combination of 3D
points and coplanar 2D points. After completing the construction, Geomet will
prompt you select Radius or Diameter as the reporting type.

Fit Plane

The Fit Plane feature permits the creation of a plane fitted through a set of previ-
ously measured or constructed features. These features can be 3D points or codirec-
tional 1D points, but a combination of different types. 
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Recalling Features

The Recall Feature command permits any feature on the report stack to
be copied to the end of the report. There exists two methods of recalling
features in Geomet, one feature is through the use of the mouse, the other
by selecting the Recall key < h >.

Recalling features through the use of the mouse pro-
vides a fast, but simple recall. For example you can
select a single or multiple group of features by highlight-
ing the features in the report and then right-click to acti-
vate the feature sub-menu and choose [Recall Features],
see figure 5.11a.

The second method performs single feature recall
through the use of the Recall key, < h >. Press the Recall
key and you will be prompted to enter the feature num-
ber, see figure 5.11b.

1D or 2D Point

Recalling 1D and 2D points from a previous PCS into a
PCS that has been realigned, rotated or skewed can pro-
duce meaningless results. Geomet will recast the original
1D point into the new PCS correcting the probe vector.

3D Point

Recalling a 3D Point or Sphere will recast the XYZ posi-
tion into the new PCS.

Circle

Recalling a Circle into a new PCS will result in Geomet
prompting you whether to recall the center as a 3D point
or attempt to fit the circle into the new PCS, see figure
511c.

Line

Recalling a Line into a new PCS will result in Geomet
prompting you whether to recall the 1D pierce axis point
as a 3D point or attempt to fit the line into the new PCS,
see figure 511c.

Plane

Recalling a Plane results in a prompt to select a PCS
pierce axis, see figure 5.11d.
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Recall PCS Base Components

Performing the command, Recall PCS Components < ⇑ > + < H > allows
you to recall a component of a PCS as a feature. When you press the
Recall Comps key, a dialog activates from which you select the desired
part coordinate system by number, see figure 5.12.

When you have completed selecting the PCS, you then
request to create a plane by selecting a PCS base plane
(XY, YZ or ZX corresponding to the plane desired), or
create a 3D Point from the origin, select the button < 3D
>, see figure 5.13.

Note: if you have only one PCS established, the dialog in
figure 5.12 will be omitted.
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Feature and Form Tolerance
In this chapter we will discuss how to apply bi-lateral and GDT tolerance to fea-
tures as well as the use of form tolerance on feature characteristics and relation-
ships.

Geomet supports Datum Bonus Tolerance on datum defined by a circle. This
allows you to use the maximum material condition of the circle used as the origin
relative to other coplanar features.

Bi-Lateral Tolerance

Bilateral Tolerance is similarity applied to all features in Geomet, We will demon-
strate the application of bi-lateral tolerance on a circle.

There are two common ways
to apply tolerance. One
method is to apply the toler-
ance each time a feature has
been measure, constructed or
recalled. To use this method,
press the Tolerance On/Off
key < r >. You will add a fea-
ture to your report toggling
the state of tolerance.

The second method involves
highlighting the feature and
right-click to activate the fea-
ture sub-menu and choose
[Edit Tolerance, see figure 6.2.

Based on the feature selected,
a tolerance dialog will appear
as shown in figure 6.1. This
tolerance dialog provides
access to both bi-lateral and GDT (if it is supported by
the feature type).

Under the Nominal, Plus and Minus columns, enter the
appropriate values. It is not required that you fill in each
characteristics, Geomet will only report the long form
only on the items completely filled in.
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GDT Tolerance

GDT Tolerance requires a basic understanding in the application of Geometric and
Dimensioning and Tolerancing as defined in ANSI 14.5.

Geomet Junior applied 2D GDT Tolerance. This form of tolerancing covers most
applications found in general business practices. Where applicable, we will point
out limitation in the application to features.

Datum Bonus Tolerance (DBT)

It is important that you apply the correct sequence to allow Geomet to calculate the
correct DBT value. Before we begin, it is important to know just how DBT effects
your application of GDT.

In Geomet, a circle that is used for the origin is the only feature that DBT work
with. When you establish your part coordinate system is when DBT is calculated.
Let us imaging that we are setting up out part coordinate system as described in
exercise 3.4 from chapter 3, When we measure the circle (step 6) would apply toler-
ance to the diameter, before establishing the origin.

Geomet calculates the available MMC on the diameter and stores that value as part
of the PCS characteristics for the base plane the circle projects into. This is accom-
plished when the origin function is performed. As mentioned earlier, DBT is only
applied to the base plane the circle used as the origin was projected into.

Applying GDT

In this example, we will
apply GDT to a circle feature,
see figure 6.3. As you will
notice in the example, we
placed a check next to Apply
DBT. This adds the value,
.0049 to the Total Tolerance
Zone. If the feature being tol-
erance did not qualify for
DBT, then this control will be
disabled.

Under Tolerance Method,
you can select MMC, LMC or
RFS depending on the
requirements for the feature.
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GeoTol

GeoTol is our acronym for form and orientation tolerance. GeoTol works on the last
measured, recalled or constructed feature for form tolerance. The table below
shows the relationships we used for the feature under consideration.

Flatness Straightness Circularity Cylindricity
Line X
Circle X
Plane X
Cylinder X
Sphere X

Orientation tolerances are applied between the last feature and either a previous
feature or the current part coordinate system. The table below shows the relation-
ships between combinations of features.

Feat 1 Feat 2 Parallelism Perpendicularity Angularity Concentricity
Line Line X X
Line PCS X X X
Circle Circle X
Circle PCS X
Circle Cylinder X
Circle Cone X
Plane Plane X X
Plane PCS X X X
Cylinder Plane X X X
Cylinder PCS X X X X
Cylinder Cone X X X X
Cone PCS X X X X
Cone Plane X X

Form Tolerance

Before we continue it is important that a basic understanding of the definition of
form tolerance is understood.

Flatness

Flatness is equal to the difference between the upper and lower bourdary planes
which are mutually parallel to and on opposite sides of the best-fit plane, which
just contains the individual, measured points.

Straightness

Straightness is equal to the difference between two lines which are mutually paral-
lel to and on opposite sides of the best-fit line, which just contains the individual,
measured points.
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Circularity

Circularity as applied to Circles equals the difference between the radii of two cir-
cles, whose center point coincide with the center of the best-fit circle, whereby the
inner circle just excludes and the outer circle just includes the individual, measured
points.

Circularity as applied to Cylinders equals the difference between the radii of two
cylinders, whose axes coincide with the axis of the best-fit cylinder, whereby the
inner cylinder just excludes and the outer cylinder just includes the individual,
measured points. 

Circularity as applied to Spheres equals the difference between the radii of two
spheres, whose centers coincide with the best-fit center of a multipoint sphere,
whereby the inner sphere just excludes and the outer sphere just includes the indi-
vidual, measured points.

Circularity as applied to Cones equals the difference between the radii of two
Cones whose axes coincide with the axis of the best-fit Cone and the included
angles are the same, whereby the inner cone just excludes and the outer cone just
includes the individual, measured points.

Cylindricity

Cylindricity equals the difference between the radii of two cylinders, whose axes
coincide with the axis of the best-fit cylinder, whereby the inner cylinder just
excludes and the outer cylinder just includes the individual, measured points.

Applying Form Tolerance

When you activate GeoTol by pressing < t >, A dialog will appear with the charac-
teristics of the last feature. In
this example, figure 6.4,
Geomet is looking at the last
feature, a -Z plane. From this
plane, we can obtain the flat-
ness, angularity, parallelism
and perpendicularity to the
PCS as defined in Reference
To:.

To select flatness, left click on
the round button next to
Flatness and select < Finish>.
This will calculate the flat-
ness over the calculated plane
of all data points.
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figure 6.4, GeoTol Dialog



Selecting one of the form tol-
erance options, angularity,
parallelism or perpendiculari-
ty, the GeoTol Wizard will
guide you through the neces-
sary steps, see figure 6.4. In
our example we choose
Perpendicularity, the wizard
prompts us for the PCS refer-
ence to work with. Select PCS
base plane YZ and click on
the < Finish > button. The
Perpendicularity zone will be
entered in your inspection
report.

The GeoTol wizard provides the necessary questions to complete the requested ori-
entation tolerance. With experience you will understand how these relationships
apply. Refer to the ANSI 14.5Y Dimensioning and Tolerancing manual for addition-
al information.
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figure 6.5, Select PCS Reference



Geomet Junior Feature Enhancements
Geomet Junior offers enhancements that allow you to expand your CMM software
as your needs grow. These enhancements add to the functionality bringing you
new tools and new features.

All Geomet products use the same database, eliminating the need to rewritre part
programs when you switch between software levels. Geomet has three levels of
CMM software: Geomet Junior, Geomet 101 and Geomet 301.

Geomet Junior

Geomet Junior is designed for basic 3D inspections. When you purchase a CMM
from Helmel Engineering, Junior is included to help get you up and running with-
out the expense of a higher level of CMM software. Geomet Junior has four options
from which to expand the basic system.

Geomet Junior - Advanced PCS and Stylus

The option, Advanced PCS and Stylus support opens the
number of available part coordinate systems (PCS) and
stylus you can have active during a part inspection.
Geomet Junior, by default, has only one PCS and one
stylus available. The PCS can be redefined during a
inspection, however the ability to recall a previous
defined PCS is not available. This option opens the abili-
ty to have several PCSs in the same part program and
seamlessly switch between them.

The Stylus Manager is activated with this option provid-
ing you expanded usage of several stylus types and
number available within your part program. Through
the stylus manager, you can qualify a 5-way stylus clus-
ter and then switch between them during your part
inspection. Additionally, you can measure a through
bore with one stylus and complete the same bore with
another stylus from the opposite side providing you
greater access to a single feature that a single stylus can not deliver.

Geomet Junior - Programming

The Programming option activates the auto-cycle mode that takes your self-teach
program and cycles it. All inspection steps that you create in Geomet are by default
program steps that are part of a program. Once you teach a part inspection, you can
then run it. Geomet Junior steps you through the sequence performing all actions
for you. All you do is capture the data points.
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Geomet Junior - Direct Computer Control (DCC)

The DCC option is designed around CMM’s that have drive systems for the XYZ
axes. This allows Geomet Junior to run your part inspections completely under
DCC control. The DCC option include the Programming option, but not the
Advanced PCS and Stylus support.

As with all Geomet levels, your part inspections that were created in manual mode
are fully compatible for use on a DCC system, all you do is add the motion path. 

Geomet Junior - GeoStat

GeoStat is a Interactive Statistical
Process Control package. We call it
interactive because at any time
you can review the latest data that
is captured from the Geomet part
program. Even during a part pro-
gram run, you can review the
changes immediatly following the
feature in question.

GeoStat requires that the
Programming option has been
activated.
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